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Preface

Preface

About This Book

This book documents version 2 of PocketGIS Connection for
Windows 2000/XP Computers.

About PocketGIS Connection

PocketGIS Connection is a map data exchange utility for
PocketGIS.  PocketGIS Connection can read data in a variety of
data formats and download it onto a mobile device running
PocketGIS.  The utility can also upload data from a mobile device
and save it in one of several data formats.  This version of
PocketGIS Connection supports exchange of data with PocketGIS
running on Mobile Windows CE computers.

Related Books

This book documents the PocketGIS Connection application.
This should be considered as an intoductory guide as some of
the more advanced features are described in the ‘Readme’
document that is installed with the software.

Before you attempt to use PocketGIS Connection you should be
familiar with the Windows Operating System and how it’s
standard controls operate.  This will be documented in the user
manual that came with your computer and on-line help.



vi

PocketGIS Connection User Manual

You should also read the PocketGIS User Manual which
documents the PocketGIS application for which this utility is an
auxiliary component.

Documentation relating to specific file format translators can be
found in the “Translator Notes” folder which can be found in
the PocketGIS Connection release folder.  A shortcut to this
folder is provided on the Windows Start -> Programs ->
PocketGIS menu.

This book assumes that the reader is familiar with Geographical
Information Systems and the data used with such systems.

How to use this book

This book is both an introduction and a reference guide to
PocketGIS Connection.  You must read this manual carefully in
order to learn the basics of working with PocketGIS Connection.

Chapter 1 -  Installation & SetupChapter 1 -  Installation & SetupChapter 1 -  Installation & SetupChapter 1 -  Installation & SetupChapter 1 -  Installation & Setup.  Follow the instructions
in this chapter to install PocketGIS Connection on to your
Windows computer.  This chapter also explains how to connect
your mobile device to your Windows computer.

Chapter 2 -  Downloading data to your mobile deviceChapter 2 -  Downloading data to your mobile deviceChapter 2 -  Downloading data to your mobile deviceChapter 2 -  Downloading data to your mobile deviceChapter 2 -  Downloading data to your mobile device
describes how to transfer map data from your computer to your
mobile device.

Chapter 3 -  Translation SchemesChapter 3 -  Translation SchemesChapter 3 -  Translation SchemesChapter 3 -  Translation SchemesChapter 3 -  Translation Schemes describes how to control
the way data is formatted and stored within PocketGIS on your
mobile device.

Chapter 4 -  Uploading data from your mobile deviceChapter 4 -  Uploading data from your mobile deviceChapter 4 -  Uploading data from your mobile deviceChapter 4 -  Uploading data from your mobile deviceChapter 4 -  Uploading data from your mobile device
describes how to transfer map data from your mobile device to
your computer.
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Chapter 1

Installation & Setup

System Requirements

PocketGIS Connection requires an x86 Windows computer
running Windows 2000, XP, or later.  If you will be using
PocketGIS Connection with PocketGIS for Handheld PC, Palm-
sized PC, Pocket PC or Windows® CE then you will also need to
install ActiveSync 3.0 or later.  ActiveSync will have been
supplied with your mobile device.

Installing PocketGIS Connection

PocketGIS is installed with the main PocketGIS product - see the
PocketGIS User Manual for more information.

Make sure you have read and agree to the softwareMake sure you have read and agree to the softwareMake sure you have read and agree to the softwareMake sure you have read and agree to the softwareMake sure you have read and agree to the software
license included with this software.  By install ing andlicense included with this software.  By install ing andlicense included with this software.  By install ing andlicense included with this software.  By install ing andlicense included with this software.  By install ing and
using PocketGIS Connection you are agreeing to theusing PocketGIS Connection you are agreeing to theusing PocketGIS Connection you are agreeing to theusing PocketGIS Connection you are agreeing to theusing PocketGIS Connection you are agreeing to the
terms of this l icense.terms of this l icense.terms of this l icense.terms of this l icense.terms of this l icense.

To open the application select “PocketGIS Connection” from the
Start -> Programs->PocketGIS menu.
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Setting Options

There are a few options you need to configure before using
PocketGIS Connection.  The options dialog is accessed by
selecting “Options...” from the “Edit” menu.

During data translation PocketGIS Connection creates some
(possibly large) temporary files on your computers hard disk
drive.  You can use the “Working Folder” page to choose where
those files are created.
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Connecting a Windows mobile device to your computer

Connect your Windows mobile device to your desktop computer
using ActiveSync - consult the documentation that came with
your device for instructions on how to do this.
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Chapter 2

Downloading data to
your mobile device

This chapter explains how to transfer map data from a Windows
computer to a mobile device running PocketGIS.  This process is
known as “Downloading”.

Selecting Data Files for Download

Begin the downloading process by selecting the map data files
you wish to transfer to your mobile device.

First run PocketGIS Connection from the Start menu.
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Then choose “Select...” from the “File” menu - the Select File(s)
to translate dialog will appear.

Navigate to the folder containing the data files you wish to
download and select them by using the mouse and/or shift/
control keys.

PocketGIS Connection will examine each of the selected files to
identify it’s format and establish whether any of the installed
translators can handle the file.

Pressing the “Stop” button will abort the file identify process.  It
may take a few seconds before the operation ends.

When each of the files has been examined the “Files to
Translate” window will appear.

The files you have selected will be listed in the window.
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The “Name” column lists the file name, the “Format” indicates
the data format of the file, and the “Description” column
contains further information on the file.  The exact contents of
the “Description” column vary depending on the format of the
file and it’s contents.  The “Records” column gives the number
of records in the file.  Depending on the format of the file the
number of records may, or may not, correspond to the number
of map features.  The “Scheme” column is described below.

Files will be ordered first by format, then by description and
finally by file name.

If any of the files are unrecognised by the installed translators,
the format and description will be given as “Unrecognised” - you
will not be able to download these files.  Alert messages will
appear to warn you if any or all of the selected files are
unrecognised.  You may need to install a translator for the
unrecognised files (if one is available) - if so, refer to Chapter 1
for information on how to do this.  If there is no translator
available for the data contact Technical Support to enquire
about possible support for the data format you have.

You can remove files from the “Files to Translate” window by
selecting them and choosing “Delete” from the “Edit” menu.
You can add files to the list by choosing “Select...” from the
“File” menu.

Tiled Datasets

Some datasets are supplied as a series of tiles in separate files.
When you download a map to a mobile device the old copy of
that map dataset is deleted (if it exists).  You must always
download all of the tiles that you require - you cannot just
download a few of the tiles.

Introduction to Translation Schemes

Each type of data you download needs a Translation Scheme
which controls certain properties and details of how the data is
formatted and stored within PocketGIS on your mobile device.
The scheme also provides detailed control over the attributing
forms associated with each type of map feature.
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Schemes for certain commercial datasets may have been
installed with PocketGIS Connection.  An Administrator may
have set up the Translation Schemes for you.

You must create or select a Translation Scheme before you can
download the map data.  Creation of Translation Schemes is
described in the next chapter.

To select an existing Scheme, highlight the data file for which
you want to assign the scheme and choose “Select...” from the
“Scheme” menu.

Choose the scheme you wish to use with the data and press the
“OK” button.  It is essential that the chosen scheme is
appropriate for the selected map data files - if the incorrect
scheme is chosen you will get a strange result.  The name of the
assigned Scheme will appear in the last column of the “Files to
Translate” window.

If you have translated data of the selected type before, then the
last Scheme that was used may be selected for you
automatically.  In this case you do not need to create or select a
scheme.  You can however create or select a different scheme if
you wish.

The Select Scheme function behaves differently depending on
the format of the data you are using.  If you are using a format
which does not describe the dataset it contains (e.g. Shape Files)
then you select schemes on a file by file basis (you can highlight
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multiple files and select a scheme for them).  If however you are
using a format such as NTF which does describe the dataset,
then the selected scheme will be assigned to all files of that type,
regardless of the particular file that was selected.

Downloading maps to the mobile device

Once you have selected the required files, and ensured that a
Translation Scheme has been assigned, you can choose the
“Download Map...” option from the “PocketGIS” menu.

If your mobile device is not already connected to PocketGIS
Connection, the connect dialog will appear.

You will need to establish a connection with PocketGIS running
on your mobile device.  For Windows mobile devices establish an
ActiveSync connection.

The connect dialog will close automatically once the connection
with the mobile device has been established.

If you have not downloaded data of the selected type before, or
you are operating PocketGIS in “Multiple View Mode”, the “Map
Store Options” dialog will appear.  [Multiple View Mode is
described in the PocketGIS User Manual].
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The ”Store” popup menu allows you to chose whether the map
data will be placed on the devices internal main memory, or
onto a data storage card.  By default a storage card is always
selected if one is available.  Press “Continue” to proceed with the
download.

If you are in the default “Single View” mode of PocketGIS, and
you have downloaded data of this type before, the map data will
automatically be placed on the same store as previously selected
(deleting the old version in the process).....   In this case the “Map
Store Options” dialog will not appear.  Note:  you wil l  not be  Note:  you wil l  not be  Note:  you wil l  not be  Note:  you wil l  not be  Note:  you wil l  not be
asked to confirm the deletion of your old data.asked to confirm the deletion of your old data.asked to confirm the deletion of your old data.asked to confirm the deletion of your old data.asked to confirm the deletion of your old data.  This is
to ensure that the download operation is as simple as possible.

If PocketGIS is in Single View Mode, the map will be
automatically added to the current Map View (if it is not already
present).  If PocketGIS is in Multiple View Mode a checkbox on
the Map Store Options dialog will determine if the Map is added
to the View.

A progress dialog will appear while the download is taking place.

You can press the “Stop” button at any time to abort the
download.  It may take a few seconds before the operation stops.
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Translation Schemes

This chapter explains how to create, modify and configure
Translation Schemes.

About Translation Schemes

Each type of data you download to PocketGIS needs a
Translation Scheme which controls certain properties and
details of how the data is formatted and stored on the mobile
device.

PocketGIS stores data in a series of maps.  Each map contains
one or more layers.  Each layer has one or more features which
in turn can have a number of attributes.  Maps can also have
tables of values which provide “pick lists” for attribute data
entry.  You can also create display schemes, which define which
features are displayed at which scale, and legends, which define
feature symbology.

The Translation Scheme defines whether the data is read only or
read / write, the coordinate units (e.g. centimetres) that the data
is stored in, and which elements of the data should be
downloaded.  You can also change the names of map features
and attributes to make them more understandable.
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You can group map features into layers which allows you to
control the visibility and drawing order of the features in
PocketGIS.

Translation Schemes can initially be created by analysing the
data structure of sample data files.  This saves you having to
construct the Scheme manually.  You can create and use a
scheme without any map data files if you want to construct a
new empty map - this is described in “Using a Translation
Scheme Without Input Data” below.

Creating a Translation Scheme

This section describes how to create a scheme from an input
map data file.

To create a Translation Scheme, first select the map data file(s)
with which the Scheme is to be used.  This is described under
“Selecting Files for Download” in the previous chapter.  If the
data you are using is tiled you should select as many of the files
as you have available - this will ensure that the Scheme correctly
represents the diversity of the features in the dataset.

When you have selected the file(s), highlight the file for which
you wish to build the Scheme and choose “Create...” from the
“Scheme” menu.  If the data is in a format which does not
describe the dataset it contains (e.g. Shape file) then the Scheme
will only relate to the file you selected.  If however you are using
a format such as NTF which does describe the dataset, then the
Scheme will be built from all files of that type currently listed in
the “Files to Translate” window.

A progress window will appear while the Scheme is being built.

You can press the “Stop” button at any time to abort the
process.  It may take a few seconds before the operation stops.
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Once the Scheme has been built the Scheme Window will appear.

Modifying an existing Translation Scheme

To modify an existing Translation Scheme, first select the data
files to which the scheme relates.  This is described above and in
the previous chapter.

When you have selected the file(s), highlight the file whose
scheme is to be modified and choose “Modify...” from the
“Scheme” menu.  The Scheme Window will appear.

The Scheme Window

The hierarchical list shows the content of the data.  The map is
represented by a ‘N-E-S-W’ icon and appears first in the list.
Layer entries appear indented from the map entry and have a
“layered square” icon.  Feature entries appear indented from a
layer entry and have a gray icon with a representation of the
feature type (i.e. line, point, etc.).  Table entries have a “grid”
icon and appear at the same level as layers.  Display Scheme
entries have a tick list icon and Legend entries have a symbology
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icon.  You can use the +/- controls to expand or collapse the
map and layer items.

You double click on a map, layer, feature, table, display scheme,
or legend to access windows which allow you to set their
properties.

Setting Scheme Details

To set the name of the Scheme, select “Details...” from the
Scheme menu, the Scheme Settings Window will appear.

The Scheme Details section gives the Schemes name and details
of the data classification.  The name is the one that will appear
in the “Select Scheme” window.  When you first create a scheme
you can change this name but it must be unique - you will be
warned if the name you choose is not unique when you close the
window.  If you are editing an existing scheme you will not be
able to change it’s name.  The classification gives details of the
feature schema version if this information was available in the
data file.  If the information was not available this field contains
the date you created the Translation Scheme.

Setting Map Properties

To set the properties relating to the whole dataset, double click
on the map entry in the list.  The map entry appears first in the
list and has a “N-E-S-W” icon.  Double clicking this entry will
bring up the Map Settings Window.
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The Map Details section allows you to set the name that the map
will have in PocketGIS.  PocketGIS uses the map name as a
unique identifier for the map.  You should ensure that the map
name is unique and once you have decided on a name you
should avoid changing it.  The copyright field allows you to set
the copyright statement which is displayed at the top of the
PocketGIS map display.  For some datasets the copyright field
will be set automatically and will not be editable.

The download options section provides items to control the
format of the data and whether feature id’s are downloaded.
The format types are “Read Only” and “Read / Write”.  If you
wish to modify the data in PocketGIS then you should select
“Read / Write”.  “Read Only” should be used for reference and
background data.  Read Only data may draw faster and normally
takes up less space on the mobile device.  Ticking the “Download
feature id’s” checkbox will ensure that the original file record id
of each feature will be placed in the file created when you
upload the map.  For some formats this will only happen if you
upload just the changes.  Record id’s cannot be viewed in
PocketGIS unless your data also contains them as a feature
attribute.  This item only effects data stored in “Read / Write”
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format and should be set if you will be uploading change only
data.

The Units section allows you to define the coordinate units of
the data in the import file, and the units of the data in
PocketGIS.  For some datasets these items will be preset and you
will not be able to change them.  Be careful to assign these items
correctly.  PocketGIS stores coordinates as integer values.
Therefore if, for example, your data is to centimetre accuracy
you should choose “centimetres” as the PocketGIS units.  If you
were to select “meters” each coordinate would be rounded to the
nearest meter.

Adding, Modifying & Removing Layers

Each map has at least one layer.  If the dataset you are using has
many features of different types then it can be advantageous to
divide the map into several layers.  This allows the layers to be
selectively displayed in PocketGIS.  You can also separate out
types of features, such as points, and then configure PocketGIS
so the points will draw last.  This will prevent other features,
such as lines, from drawing over point symbols.

To add a new layer, first select the map entry in the main
Scheme window (map entries have a “N-E-S-W” icon).  Then
choose “Add Layer” from the “Scheme” menu.  A new untitled
layer will be created - double click on the new layer to change
it’s name.

To modify a layer double click on it to display the layer Settings
Window which is described in the next section.

To assign a feature to a layer, select the feature in the list and
choose the relevant layer from the “Set Layer” item in the
“Scheme” menu.  You must have at least two layers for the “Set
Layer” item to be available.

To remove a layer, first reassign all it’s features to other layers.
Then select the layer and choose “Delete” from the “Edit” menu.
You cannot remove the last layer in a map.

To change the order of a layer in the map, select the layer and
then choose “Move Up” or “Move Down” from the Scheme menu.
The layer will move up or down in the list.  You need at least two
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layers to be able to do this.  The default ordering of layers in
PocketGIS  Map Views is the same as the order in the Translation
Scheme; so it is a good idea to configure the required layer
order in PocketGIS Connection.  PocketGIS draws layers in
reverse order so the last layer will draw first and the first layer
will draw last.

Setting Layer Properties

To set the properties relating to a layer, double click on a layer
entry in the list.  The layer entry appears indented from a map
entry and has a “layered square” icon.  Double clicking this
entry will bring up the Layer Settings Window.

The Layer Details section allows you to set the name the layer
will have in PocketGIS.  You can also control whether the layer is
downloaded.  If “Download this layer” is not ticked then the
layer, and all the features assigned to it, will not be downloaded.
Note that layers which are not downloaded will not be present in
an uploaded file.

Adding, Modifying & Removing Features

Each layer has at least one feature.  An initial list of features is
automatically added to the Scheme when it is created.  If the
data file used to create the Scheme does not contain a complete
description of your data set you may need to add additional
features manually.

To add a new feature, first select either a layer or feature entry
in the main Scheme window (layer entries have a “layered
square” icon).  Then choose “Add Feature” from the “Scheme”
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menu.  A blank Feature Settings Window will appear, fill in the
details of the new feature, as described in the next section, and
press the “OK” button.  If you selected a layer then the new
feature will appear at the end of the list of features for that
layer; if you selected a feature the new feature will appear after
the selected feature in the list.  You can also create a feature by
duplicating an existing feature.  To do this select the original
feature and choose “Duplicate” from the “Edit” menu.    The
duplicate feature will have the same properties and attributes as
the original.  You must change the name and code of the new
feature to avoid conflict with the original.

To modify a feature double click on it to display the Feature
Settings Window which is described in the next section.

To remove a feature select it and choose “Delete” from the
“Edit” menu.  You must be certain that a feature will not appear
in any data files if you are to remove it.  You cannot remove the
last feature in a layer.

To change the order of a feature in a layer, select the feature
and then choose “Move Up” or “Move Down” from the Scheme
menu.  The feature will move up or down in the list.  You need
at least two features in the layer to be able to do this.

Setting Feature Properties

To set the properties relating to a feature, double click on a
feature entry in the list.  The feature entries appear indented
from a layer entry and have a square gray icon with a
representation of the feature type (i.e. line, point, etc.).  Features
whose type is not defined have a question mark icon.  Double
clicking a feature entry will bring up the Feature Settings
Window.  This window also appears when you create a new
feature.
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The Feature Settings Window contains a number of tabbed
pages, each containing a group of configuration controls.  Click
on the relevant tab to view each page.  No permanent changes
are made to the feature until you press the “OK” button.

Feature Details

The Feature Details page allows you to set the name, code, type
and capture status of the feature.

The name is the user visible description that appears in
PocketGIS and is unrelated to the coding of the feature in import
and export files.  This means that you can change the name to
something friendly and when the map is uploaded the original
code will be used in the uploaded file.

As already indicated, the code is the internal description of the
feature used by data files which are exchanged between
PocketGIS and your desktop computer.  The code may have been
preset by an imported data file in which case you will not be
able to change it.

The type specifies whether the feature is a line, point, etc.  This
may be preset in which case you will not be able to change it.
Features for which the type is “Unknown” will not be
downloaded.

The “Allow capture of this feature” checkbox controls whether
new instances of this feature can be captured in PocketGIS.  If
you do not want users to capture this feature make sure that the
checkbox is not ticked.
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Feature Orientation

The Orientation page provides the means to specify an attribute
which contains a point or text feature’s orientation value.  This
value must be set if the PocketGIS Rotated Symbol style is to be
used.  If the “Orientate to snapped line” checkbox is set then
digitising a new point, when snapping onto a line, will preset the
orientation value so the point is perpendicular to the line.  This
can be useful for certain point features.  The Orientation
controls only apply to point and text features.

Feature Text

The Text page provides the means to specify the attribute which
contains a text feature’s text string.  The Text controls only
apply to text features.
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Feature Annotation

The Annotation page allows you to specify an attribute whose
value is used for annotations.  This value must be set if the
PocketGIS Annotated Line style is to be used.  If the “Generate
Annotation points” checkbox is set then the coordinate of the
annotation will be automatically calculated when the map is
downloaded.  If your data already contains annotation points
then this checkbox should not be ticked.  Currently the
Annotation controls only work with line features.

Feature Attributes

The Attributes page lists all the attributes associated with a
feature.  Double clicking an attribute will bring up the Attribute
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Settings Window which is described below.  The use of the New,
Change and Remove buttons is described in the next section.

Adding, Modifying & Removing Attributes

Each feature can have a number of attributes.  An initial list of
attributes is automatically added to the feature when the
Scheme is created.  If the data file used to create the Scheme
does not contain a complete description of your data set you
may need to add additional attributes manually.  Features do
not need to have any attributes.

To work with attributes you must first display the Feature
Settings Window as described in the previous section.  Attributes
are accessed from the Attributes page of the Feature Settings
Window.

To add a new attribute press the “New” button on the Attributes
page.  A blank Attribute Settings Window will appear, fill in the
details of the new attribute, as described in the next section, and
press the “OK” button.  If you selected an attribute in the list
then the new attribute will appear after the selected attribute;
otherwise the attribute appears at the end of the list.

To modify an attribute double click on it to display the Attribute
Settings Window which is described in the next section.
Alternatively you can select the attribute and press the
“Change” button.

To remove an attribute select it and press the “Delete” button.
You must be certain that an attribute will not appear in any data
files if you are to remove it.

Setting Attribute Properties

To set the properties of an attribute first open the relevant
Feature Settings Window as described in the “Setting Feature
Properties” section.  Then double click on the attribute you wish
to configure.  The Attribute Settings Window will appear.  This
window also appears when you create a new attribute.
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The Attribute Settings Window contains a number of tabbed
pages, each containing a group of configuration controls.  Click
on the relevant tab to view each page.  No permanent changes
are made to the attribute until you press the “OK” button.

Attribute Details

The Attribute Details page allows you to set the name, code and
type of the attribute.

The name is the user visible description that appears in
PocketGIS and is unrelated to the coding of the attribute in
import and export files.  This means that you can change the
name to something friendly and when the map is uploaded the
original code will be used in the uploaded file.

As already indicated, the code is the internal description of the
attribute used by data files which are exchanged between
PocketGIS and your desktop computer.  The code may have been
preset by an imported data file in which case you will not be
able to change it.

The type specifies whether the attribute is an integer, string, etc.
This may be preset in which case you will not be able to change
it.  The “Download this attribute” checkbox controls whether the
attribute is downloaded to PocketGIS.  Note that attributes which
are not downloaded will not be present in an uploaded file.  The
“Upload this attribute” checkbox controls whether the attribute
will be present in an uploaded file.  This allows you to download
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an attribute for reference in PocketGIS, but not include it in
uploaded data.

Attribute Options

The Options page provides controls to set various conditions for
the attribute.

If an attribute is mandatory then a value must be present for
each feature in the data that is downloaded.  The download will
fail with an error if any feature does not have a value set for this
attribute.  In addition the PocketGIS Attribute Dialog will insist
that a value be provided for this attribute before it can be
closed.

If an attribute is read only then it’s value cannot be changed or
entered in PocketGIS, even if the map is downloaded as “Read /
Write”.

If an attribute is visible then it will appear in the PocketGIS
Attributes Dialog.  Attributes which are not visible will not
appear in this dialog.  Attributes such as orientation values
should not be visible.

The Remember option causes the PocketGIS attributes Dialog to
maintain a menu of the last few values chosen for an attribute.
This allows the user to pick a value without entering it afresh for
each feature whose attributes are modified.  This option is not
available for all attribute types and is most useful for string,
integer and real attributes.
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The Auto-Set option causes the PocketGIS attributes dialog to
automatically fill a value for the attribute when a new feature is
created - it has no effect on preexisting features.  This option is
not available for all attribute types.  For string, integer and real
attributes the last value entered for the previous feature (if any)
is automatically inserted.  For date and time attributes the
current date and time (respectively) is inserted.

Attribute Field Widths

The Field Widths page allows you to control the “width” of
certain types of attribute - i.e. the maximum number of
printable numbers or letters the attribute can occupy.

The File width defines the width in import and export files
which have a defined field format (e.g. NTF) but is not relevant
to files with a free format (e.g. CSV).  This value must be correct
for import files with defined field widths.  This value may have
been preset by the file translator in which case you will not be
able to change it.  A value of 0 (zero) means that the width is
variable.

The Editor width defines the maximum number of characters
that can be entered for the attribute in the PocketGIS Attribute
Dialog.  A value of 0 (zero) means that there is no limit.  You
cannot set this value for all attribute types.

The Lines item defines the number of data entry lines that are
displayed for the attribute in the PocketGIS attributes Dialog.
This will normally be ‘1’ but can be set to more than 1 for, say, a
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comments field.  This value has no effect on date, time, logical
and attributes for which a lookup table has been defined.�

Attribute Default

The Default Value page allows you to specify the value that an
attribute will assume when the “Default” function is selected in
the PocketGIS Attributes Dialog.  This option is not available for
all attribute types.

Attribute Lookup Table

The Lookup Table page allows you to specify a table of values
that are used to provide a “pick list” of options for the attribute
in the PocketGIS Attributes Dialog.  When a lookup table is
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assigned to an attribute, values are selected from a menu or
alphabetised list rather than by entering the value directly.  The
data is stored as an internal code value but the user sees a
meaningful description provided by the table.  Lookup Tables
can only be assigned to string and integer attributes.

You must have already created a Lookup Table as described in
“Adding, Modifying & Removing Tables” below.

The “Table” popup lists all the available tables for the given
attribute.  String attributes can only use alphanumeric tables
and correspondingly integer attributes can only use numeric
tables.  Select the table you wish to use with the attribute or
“None” if you do not want a lookup table assigned.

Normally, uploaded data will contain the internal code values
for the data, rather than the lookup table descriptions.  If you
want the uploaded data to contain the textual descriptions
instead then tick the “Export Lookup Values” box.  At the time of
writing this setting is not observed by all data translators so be
sure to check the “Translator Info” folder for details.

The Lookup Table mechanism can be used to restrict the
allowable values for an attribute based on the setting of another
attribute - the one that this attribute is dependent upon.  This is
controlled via the “Dependent Attribute” item.  This item is
available when a Category Lookup table is assigned to the
attribute by the “Table” item.  See “Setting Table Properties”
below for information on how to set up a Category Lookup table.
Select the attribute that this attribute depends upon using the
“Dependent Attribute” item.  Setup the Category Lookup table
with a category for each value of the other attribute.  In the
PocketGIS Attributes Dialog the user will only be able to select
values from a category that equates to the setting of the other
attribute.  If there are no entries for a category then this
attribute will have no allowable values.  For example:  if the
other attribute can contain ‘Tree’, ‘Shrub’ and ‘Flower’ then
create a table with categories named ‘Tree’, ‘Shrub’ and ‘Flower’.
When the other attribute has a value of ‘Tree’ then this attribute
can only be set to values in the ‘Tree’ category.  When the other
attribute is set to ‘Flower’ then this attribute can only be set to
values in the ‘Flower’ category, and so on.  Note that if the other
attribute is using a lookup table then the categories for this
attribute must be the internal codes rather than the descriptive
values.  Also, you will not be allowed to set up circular
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references so not all attributes will appear in the “Dependent
Attribute” popup list.

Adding, Modifying & Removing Tables

Attributes can be setup to use a list of descriptive values for data
entry and viewing.  This is useful to provide lists of available
choices and to map internal codes to human readable
descriptions.  Whilst the user sees these descriptions, internally
the data is stored as codes.  This is achieved by defining a
lookup table which maps the internal codes to the descriptive
values.  If your data contains codes to represent data values, and
/ or you want to provide a “pick list” of values in the PocketGIS
Attributes Dialog, then you will need to define a lookup table.  It
is possible that a lookup table may have been created
automatically from the data file but most file formats do not
contain this information.

To add a new table, first select any entry in the main Scheme
window.  Then choose “Add Table” from the “Scheme” menu.  A
blank Table Settings Window will appear, fill in the details of the
new table, as described in the next section, and press the “OK”
button.  If you selected a table then the new table will appear
after the selected table in the list; otherwise the new table will
appear at the end of the list of layers and tables for that map.

To modify a table double click on it to display the Table Settings
Window which is described in the next section.

To remove a table select it and choose “Delete” from the “Edit”
menu.  Any attributes which are using the table will revert to
working with raw data or internal codes.

Setting Table Properties

To set the properties relating to a table, double click on a table
entry in the main Scheme window.  The table entry appears
indented from a map entry and has a “grid” icon.  Double
clicking this entry will bring up the Table Settings Window.  This
window will also appear when you create a new table.
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Table Details

The Table Details section allows you to set the name, table type
and code type of the table.

You must give the table a unique name, enter this in the Name
field.

There are two types of table, Plain Lookup and Category Lookup.
A Plain Lookup table simply contains a list of code / descriptive
value pairs.  The descriptive values will appear in a menu or (if
there are a lot of them) an alphabetised list in the PocketGIS
Attributes Dialog.  A Category Lookup table has a list of
categories with each code / value pair belonging to one
category.  If an attribute is assigned a category lookup table then
the Attributes Dialog will display a picker which allows the user
to first identify a category and then the value required.
Category Lookup tables are used to group data values and are
useful for long lists of values and values which do not sort well
in alphabetical order.  Category Lookup tables are also used to
make attributes depend upon other attributes - see “Setting
Attribute Properties” above.  Choose the type of table from the
“Type” item - you can only change the type of a table when it
has no entries.

You can choose the data type of the internal codes used by the
table - either numeric or alphanumeric.  Numeric tables are used
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with integer attributes and alphanumeric tables are used with
string attributes.  Use the “Code Type” item to set the data type
of the table codes - you can only change the type of a table
when it has no entries.

Plain Lookup Tables

If you are working with Plain Lookup tables then the
“Categories” button is inactive - Plain Lookup tables do not have
categories.

To add an entry to a lookup table press the “New” button in the
Table Settings Window.  The Table Entry Window will appear.

Enter the code and the corresponding descriptive value and
press “OK”.  For plain lookup tables the category popup will be
inactive.

If an entry was selected in the Table Settings Window when you
pressed the “New” button, then the new entry will appear after
that entry in the list; otherwise it will appear at the end of the
list.

To change a table entry either select it and press the “Change”
button, or double click on the entries code.

To remove a table entry select it and press the “Remove” button.

When you have finished changing the table press the “OK”
button to assign the changes to the Scheme, or “Cancel” to
discard the changes.



3-21

Translation Schemes

Category Lookup Tables

When a Category Lookup table is being modified the Table
Contents section of the window includes a column showing the
category of each entry.

Pressing the “Categories” button will display the Table
Categories Window.    You cannot add entries to a Category
Lookup table until at least one category has been defined.

To add a new category press the “New” button - the Category
Window will appear.
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Enter the name of the new category and press “OK”.  If a
category was selected in the Table Categories Window when you
pressed the “New” button, then the new category will appear
after that category in the list; otherwise it will appear at the end
of the list.

To change a table category either select it and press the
“Change” button, or double click on the category.

To remove a table category select it and press the “Remove”
button.  You cannot remove the last category in a table.

Once you have defined one or more categories you can add,
modify and remove entries in the same manner as for Plain
Lookup tables.  The only difference is that you can choose a
category for an entry in the Table Entry Window.

Adding, Modifying & Removing Display Schemes

Display Schemes define at which scales map features are drawn.
You do not need to create a display scheme but it is highly
recommended that you do.  As you zoom out on the PocketGIS
map display, more and more geometry comes into view.  This
geometry takes progressively longer to draw and the display
becomes cramped as more detail is drawn at an increasingly
smaller size.  A display scheme consists of a number of ranges
which define a minimum and maximum scale together with a list
of features to be drawn at that range.  You should construct
your display scheme so point and text features are only drawn
when you are zoomed in on a map and when you are zoomed
out only show significant line detail.
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An individual display scheme relates to a particular map layer.
You need to create separate display schemes for each layer in
your map.

To add a new display scheme, first select the layer to which it
applies.  Then choose “Add Display Scheme” from the “Scheme”
menu.  A Display Scheme Settings Window will appear, configure
the scheme, as described in the next section, and press the “OK”
button.

To modify a display scheme double click on it to display the
Display Scheme Settings Dialog which is described in the next
section.

To remove a display scheme select it and choose “Delete” from
the “Edit” menu.

Setting Display Scheme Properties

To configure a display scheme, double click on a display scheme
entry in the main translation scheme window.  The display
scheme entries appear after features, and any tables, and have a
tick list icon.  The Display Scheme Settings dialog will also
appear when you create a new display scheme.

The “Name” item sets the name of the Display Scheme.

“Range” is a popup list of all defined ranges - the settings for the
range selected here are shown in the “Feature” list.  See
“Ranges” below.
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There is a scrolling list of all the features in the display scheme.
Each feature has a checkbox to the left of it’s name.  If the
checkbox is ticked then the feature will be draw at the scales
indicated by the “Range” item (see above).  Unticked features
are not drawn.

The “Ranges” button opens the Range Dialog which allows you
to create, modify, and delete ranges.

You create new ranges by dividing up existing ranges.  Pressing
the “Divide” button will split the selected range in two.

Once there are two or more ranges it is possible to adjust the
boundaries between ranges.  Select the range you want to adjust
and type in new upper and / or lower boundaries in the edit
fields above the buttons.  To make the change press the
“Change” button.  The ranges adjoining the changed range will
adjust to take account of the new boundaries.  Pressing the
“Delete” button will remove the selected range.  To accept the
new ranges press the “OK” button, pressing “Cancel” will discard
the changes you have just made.
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Once you have created the ranges you can select the range
displayed in the feature list using the “Range” popup list.

When you have finished changing the display scheme press the
“OK” button to assign the changes to the translation scheme, or
“Cancel” to discard the changes.

Adding, Modifying & Removing Legends

Legends control the line styles and symbology used to display
the features of a given layer. You do not need to create a legend
- features will be displayed using default styles if you do not
provide a legend.

An individual legend relates to a particular map layer.  You need
to create separate legends for each layer in your map.

To add a new legend, first select the layer to which it applies.
Then choose “Add Legend” from the “Scheme” menu.  A Legend
Settings Window will appear, configure the legend, as described
in the next section, and press the “OK” button.

To modify a legend double click on it to display the Legend
Settings Dialog which is described in the next section.

To remove a legend select it and choose “Delete” from the “Edit”
menu.

Setting Legend Properties

To configure a legend, double click on a legend entry in the
main translation scheme window.  The legend entries appear
after features, and any tables and display schemes, and have a
symbology icon.  The Legend Settings dialog will also appear
when you create a new legend.
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The “Name” item sets the name of the legend.

There is a scrolling list of all the features in the legend.  The
icon indicates the features type.  Double click on a feature to
display the style editor for that feature.  Depending on the
features type the Line, Point, Text, or Area settings dialog will
appear.

Line Settings

Double clicking a line feature will bring up the line settings
dialog.

This dialog provides controls which can be used to configure the
symbology of a line feature.

The “Line Width” item provides a popup list of line widths.  This
allows you to choose a thick line for prominent features.
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The “Line Pattern” item lets you choose between a solid and a
dashed line.  Note that you can only have a dashed line if the
line width is 1.

The “Line Colour” item lets you choose the colour of the line.

Area Settings

Double clicking an area feature will bring up the area settings
dialog.

The line settings define the border of the area and the fill
settings define the inside of the area.

The “Line Width” item provides a popup list of line widths.  This
allows you to choose a thick line for prominent features.

The “Line Pattern” item lets you choose between a solid and a
dashed line.  Note that you can only have a dashed line if the
line width is 1.

The “Line Colour” item lets you choose the colour of the line.

The “Fill Style” item lets you choose between a solid and a
hollow area display.

The “Fill Colour” item lets you chose the colour of a solid area.
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Point Settings

Double clicking a point feature will bring up the point settings
dialog.

The Point Settings Dialog provides controls which can be used to
configure the point feature.  By default all points have a “dot”
symbol - select and delete the circle of the dot before creating
new symbol geometry.

The gridded box is the draw area where you can create or edit
the symbol.  This is an enlarged view and each ‘box’ of the grid
represents one pixel.  The small “Preview” box shows the symbol
at actual size.

The edit controls on the left of the dialog configure the various
properties of individual symbol elements and are enabled as
appropriates.  The function of the line and fill items is as
described above.  The text item allows you to enter text into the
symbol.  Note that if a feature has an annotation attribute, the
value of that attribute will replace the symbol text when the
symbol is rendered in PocketGIS.

The row of buttons at the bottom right of the dialog allow you to
select the current draw/edit mode - these are described in the
following paragraphs.  Press the tool button to enable that
mode.
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The select mode allows you to select an existing graphic element
in the gridded area.  You will need to tap on a point in a line or
rectangle, or tap the corner of the bounding box of text or circle
/ oval graphics.  You cannot tap on the mid point of a line.  The
selected graphic element will be highlighted and the appropriate
style controls enabled.  You can change the properties of the
element using the style controls or delete the element with the
delete button (described below).

In line mode you can tap out the points of a linear element in
the gridded area.  The last point you create is highlighted with a
cross.  You can set the lines properties using the controls at the
left of the dialog.  To start a new line press the line button again.
To undo the last point you created press the back arrow button.

In box mode you can tap out the corners of the ‘box’.  The shape
you draw does not have to be rectangular and can be a polygon
of any shape.  Using the style controls on the left of the dialog
you can set the ‘box’ to be hollow or filled.

In circle mode you can tap out the top left and bottom right
corners of a circle or ellipse.

In text mode you can tap out the top left and bottom right
corners of the text’s enclosing rectangle.  You can set the text
value using the “Text String” edit field.  If the symbol is used
with a point which has an annotation attribute then the
annotation value will be substituted for the text string.

In hot spot mode you can change the position of the symbols
hot spot - just tap the new position on the grid.  The symbol’s
hot spot defines the origin of the symbol relative to the point
feature’s map coordinate.  By default the hot spot is in the
centre of the grid.
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The undo button will undo the last point you created in the line,
box, circle, and text modes.

The delete button will remove the selected graphic element from
the symbol.  Use select mode, as described above, to select an
element before pressing this button to delete it.

Text Settings

Double clicking a text feature will bring up the text settings
dialog.

The dialog provides a control that lets you choose the colour of
the text.

Using a Translation Scheme Without Input Data

You can create and use Translation Schemes without input data
files - this is useful if you want to create empty maps for
capturing new data sets.

When there are no File List or Translation Scheme windows
open, the “Scheme” menu contains the following commands:

• New

• Select & Modify

• Delete
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In addition the “PocketGIS” menu contains the “New Map”
command.

New

The “New” item on the Scheme menu will create a new
Translation Scheme without the need to provide map data.
When the scheme window opens you should use the Scheme ->
Details dialog to give the scheme a name.  Once the scheme has
been saved you will not be able change the name.  You can then
configure the scheme as described earlier in this chapter.

Select & Modify

This command will list all the schemes - select the one you want
to modify and then press “OK”.  You can then view or modify
the scheme as described earlier in this chapter.

Delete

This command will list all the schemes - select the one you want
to delete and the press “OK”.  The selected scheme will be
deleted.

New Map

This command is used to create a new, empty, map using a
translation scheme as a template.  Selecting “New Map” from the
“PocketGIS” menu will list all the schemes - select the scheme
which defines the map you want to create.  You will be
prompted for the coordinate extent of the new map.  Once the
coordinates have been supplied the new map will be created on
your mobile device.  Any map already on the device, with the
same name as the map defined in the scheme, will be deleted
without warning.
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Implications of Modifying Translation Schemes

The Translation Scheme for a dataset controls not only how the
data is downloaded, but is also used when data is uploaded
following field modification.  You should be aware that changing
a scheme between download and upload can affect how the data
is uploaded. In particular, the name of the scheme is encoded
into the map in PocketGIS and this name is used to identify the
scheme when data is uploaded.  You should not change the
name of a scheme if data that depends upon it is still held
within any PocketGIS systems. Removing or changing the types
or codes of features and attributes can prevent instances of this
data being uploaded.  In short, you should establish the scheme
for your data and be careful about if or when the scheme is
modified.

If there is no scheme for data held in PocketGIS it can still be
uploaded. The specification of data will follow a default scheme
for the data which will be generated automatically from the data
description held within PocketGIS.  These “automatic” schemes
are not saved and cannot be viewed or modified using the
Translation Scheme Window.
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Uploading data from your
mobile device

This chapter explains how to transfer map data from a mobile
device running PocketGIS to a Windows computer.  This process
is known as “Uploading”.

Selecting the map to upload

Begin the uploading process by selecting the map which you
wish to upload.

First run PocketGIS Connection from the Start menu.

Then choose the “Upload Map...” option from the “PocketGIS”
menu.

If your mobile device is not already connected to PocketGIS
Connection, the connect dialog will appear.
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You will need to establish a connection with PocketGIS running
on your mobile device.  For Windows mobile devices establish an
ActiveSync connection.

The connect dialog will close automatically once the connection
with the mobile device has been established.

A progress dialog will inform you that the map names are being
retrieved and then the “Upload Map” dialog will appear.

The map list will only contain datasets that are stored in “Read /
Write” format.  You cannot upload read only data.

Select the map you wish to upload.  If you only require the
changes that have been made to the map whilst it was on the
mobile device, tick the “Only Upload Changes” checkbox.  Press
the “OK” button to proceed.

 The “Save Map Data as” dialog will appear.
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Navigate to the directory where you want to save the uploaded
map.

The popup menu at the bottom of the dialog allows you to
choose in which file format the data should be saved.  If the
format you require is not listed you may need to install a
translator for that format (if one is available) - if so refer to
Chapter 1 for information on how to do this.  If there is no
translator available for the format you require contact Technical
Support, as described in Appendix A, to enquire about possible
support for the data format you wish to use.

Enter the file name and press the “Save” button.  A progress
dialog will appear while the upload is taking place.

You can press the “Stop” button at any time to abort the upload.
It may take a few seconds before the operation stops.

When the upload is complete the progress dialog will close.

Feature Id’s in Uploaded Data

When you choose to upload change only data from PocketGIS,
most of the data format translators will include an id against
each uploaded feature.  If you have selected “Download Feature



4-4

PocketGIS Connection User Manual

ID’s” (in the map settings dialog of your translation scheme),
then the id’s will be from the original data - except for new
features which will have an ID of zero.  If you do not select
“Download Feature ID’s” then uploaded data will have a pseudo
ID based on it’s modification / creation time.  This pseudo ID is
meaningless but unique and is provided to allow cross
referencing between data uploaded into different formats (e.g.
DXF / CSV).
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